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0. Welcome to Bitwig Studio

Welcome to Bitwig Studio! We are glad you have joined us and are
excited to help you create, compose, polish, and perform your music.

And welcome also to our Bitwig Studio 8-Track users! Bitwig Studio
8-Track is the entry-level version of Bitwig Studio that comes bundled
with selected hardware products. All of Bitwig Studio’s functions and
resources are available in Bitwig Studio 8-Track so this user guide
applies equally to both programs.

The purpose of this document is to walk you through most of Bitwig
Studio’s functions and show you how to operate the program. The
chapters and topics are arranged progressively, with basic concepts
appearing first and advanced ideas showing up later. And although this
document does not attempt to explain fundamental audio and musical
concepts, it is written for users of any stripe who want to use software
to make music.

For an initial walk-through of Bitwig Studio, consult the Bitwig Studio
Getting Started Guide. This separate document takes you through
registering, downloading, and authorizing your copy of Bitwig Studio as
well as getting your hardware devices running. It also provides an initial
look at the concepts behind Bitwig Studio and a general overview of the
program'’s interface.

In addition to the Getting Started Guide and to this document, other
resources will be mentioned when appropriate, the program itself offers
a fair amount of documentation through tooltips, and you can always
visit Bitwig's website [http://bitwig.com] for the latest information. And
please share any feedback you have or issues you encounter by visiting
our support portal [http://bitwig.com/support].

In this chapter, we will begin with links to sections that have changed in
this version and then a few pointers for those of you who started with an
earlier version of Bitwig Studio. (As usual, some items may have shifted
during the flight.) We will move on to the Dashboard, which is more

or less the command center of Bitwig Studio. Finally, we outline a few
conventions that will be used throughout this document. But you will not
make sound in this chapter; that is what the rest of this document is for.

0.1. What's New in Bitwig Studio v3

For those of you who are recent Bitwig users, hello! Here are some
pointers to new and changed sections of this document:


http://bitwig.com
http://bitwig.com
http://bitwig.com/support
http://bitwig.com/support

» The Grid, Bitwig Studio's new modular sound-design environment.
Comprising a library of 154 modules, a bevy of editing gestures, and
interactive assistance that is always on hand, you can now intuitively
build patches in Bitwig Studio (see chapter 15).

Poly Grid, a new Grid device for creating instruments, be them mono-/
poly-synths, samplers, sequenced patches, cascading drones, or
anything else you might imagine (see section 17.17.2).

FX Grid, a new Grid device for creating audio effects, including the
option of Voice Stacking, and the ability to create polyphonic effects
with voice management (see section 17.17.1).

Redesigned instrument Inspector Panel for all Bitwig devices that
support polyphony. A consistent way of accessing the three voice
modes (polyphony and two flavors of mono), Voice Stacking, and
more (see section 14.2.3.1).

Automatic project backups, keeping a copy of the most recent project
file within the project folder each time you hit save. If data corruption
ever strikes, this just might save the project.

Realtime Ruler, showing timelines in minutes, seconds, etc. on any time-
based display. Sometimes seeing the duration is necessary (see section
31D.

VU Meters in routing choosers, because seeing the signal you are
looking for is easier than remembering port names.

Reworked audio backends, sporting timing improvements for ASIO &
WASAPI (PC), CoreAudio (Mac), ALSA & PulseAudio (Linux), and Jack
(everybody).

Ableton LINK version 3, supporting start/stop synchronization.

Global GUI Contrast settings, for fine-tuning the interface on monitors
of any resolution and vintage. Found in the Dashboard under User
Interface (see section 0.3.2.5).

General Ul overhaul, including some redesigned dynamics devices, a
better pop-up style when editing parameters, and cleaner readability
across the board.

0.2. Adjustments from Version 1

For those of you who started using Bitwig Studio in version 1, welcome
back! You hold a special place in our hearts.



While new features are sprinkled throughout this document in
appropriate places, we'd like to begin by noting some features from
previous versions of Bitwig Studio that have either relocated or gone
underground.

> In earlier versions of Bitwig Studio, the Inspector Panel contains
function buttons for taking action on selected objects (usually clips or
events).

i AUDIO EVENT - EM AfricanE. [EI"."\ AfricanEasyDrums 120bpm 01
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3 51 Effect

o Master
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From version 2 of Bitwig Studio, the Inspector Panel has been freed
of these buttons to make room for additional parameters and an
enhanced interface.
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Functions are now available through the selection-sensitive menus that
appear (such as Event in the image above) and via the context menu
that appears when right-clicking on an object.

Version 2 of Bitwig Studio introduced a new class of special-purpose
modules called modulators, which can be loaded into any device
(including VST plug-ins).

For more information on using modulators, see section 14.2.1.

For descriptions of the individual modulators, see section 17.19.

These new modulator modules have rendered the older category of
modulator devices vestigial. Those devices are still present in Bitwig
Studio, however, to facilitate projects that were made in version 1.x.
You can even enable legacy devices to appear in the Pop-up Browser if
you want to keep using them.
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To enable legacy devices: right-click anywhere in the Pop-up Browser,
and then enable the Enable Legacy Devices option from the Filter
Sections header of the context menu.
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With the advent of modulator modules, most on-board modulation
sources have been removed from Bitwig's devices.
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For example, Polysynth is shown here in version 1.x with ten
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As shown above in version 2, Polysynth has only kept its two
modulation sources that have defined routings. The modulator slots
on the left, however, can facilitate any old or new modulation source.
And presets saved in Bitwig Studio 1.x are completely compatible with
version 2, automatically loading new modulators to properly recreate
your original patches.
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» Device macros used to exist at the top level of all devices. Flexible
remote controls now exist in that place, allowing either knobs, chooser
menus, or toggle buttons to be shared across each class of device
within Bitwig Studio.
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For more information on remote controls, see section 13.1.1.

While macros don't exist at the top level of all devices, they can be
added back to any preset.

To add a macro to the top level of a device preset: add either the
Macro or Macro-4 modulator modules to a device, and then assign
their knobs to the device's remote controls.
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Both the functionality of device macros is provided, as are the in-line
modulation routing buttons.

0.3. The Dashboard

The separate Bitwig Studio Getting Started Guide document is a
quick and worthwhile read if you are opening Bitwig Studio for the
first time. Don't worry about us; we'll be here when you get back.

Once you have Bitwig Studio installed and launched, the first place you
will land is a place you will return to again and again. The Dashboard
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0. WELCOME TO BITWIG STUDIO

is a central hub for finding your projects, configuring your settings,
managing library content, and accessing help. Each of these four tasks
has its own tab for navigation, and we will walk-through each of them in
turn in the following sections.

If Bitwig Studio opens to a different view, you can call up the
Dashboard at any time by clicking the Bitwig logo in the center of the
window's header, at the very top of the screen.

0.3.1. User Tab

We call the first tab of the Dashboard the user tab because it displays
the name you have registered with Bitwig. (If your username is too long,
it will simply display User.)



| USER SETTINGS

} Quick Start TEMPLATE PROJECTS

Play Keys
Acoustic and electric pianos, as well as classic keyboard sounds.

ly Project: Bundled package pb
ly Templates Illlllljllllllll Open

Play Synths
Start playing immediately with various synthesizer sounds.

ojects

New Project

Openfile... Il"uuluuul Sl

License Info... Play Drums
Classic drum machine sounds, alongside studio-recorded acoustic
drums and percussion.

Open

Performance Set
Play loops in the Clip Launcher. Explore the Browser and add your
own sounds.

Open

BITWIG DEMO PROJECTS

In Cycles
Demo song by Falko Brocksieper.

The Quick Start page shows both Template Projects (that work as
starting points) and demo project made either by Bitwig (found under
Bitwig Demo Projects) and our partners (under Partner Demo Projects).
Each demo project provides a short write-up, a list of any Bundled
packages that are required to run it, and an Open button. Clicking Open
downloads the project along with any used packages (which requires an
internet connection), and then opens the project.

The next three pages show local content and are similar in format.

The Recent Projects page shows the Bitwig Studio projects you have
opened lately. The My Projects page displays all projects found in the My
Projects path (which is defined in the Settings tab within the Locations
page), and the My Templates page shows any template projects that you
have saved.

Each of these three pages shows content in the same way. A search bar
is provided at the top of the project list for winnowing down the projects



being shown. When a project is selected (by single-clicking it), project
information is display at the bottom of the window. This includes entries
such as the last modification time and the file path to the project folder.

To open a listed project: either click the respective Open button or
double-click the project name.

Finally, every page under the user tab shares three buttons on the
middle left:

» New Project creates a blank project to let you begin working from
scratch.

» Open File... provides a standard open dialog, in case you prefer locating
a project that way.

» License Info... opens a window that displays your local license data and
provides an option for registering a new serial number.

Because exiting the Dashboard requires that you have a project file
open, trying to leave the Dashboard with no project open will send you
to the User tab. The New Project button politely flashes in this case,
indicating the quickest way to exit the Dashboard and get to work.

0.3.2. Settings Tab

The Settings tab is where Bitwig Studio's preferences generally live. We
will look at a few of these pages in detail and then take the rest in the
order that they appear.

0.3.2.1. Audio Settings

The Audio page defines a number a of important settings for audio
operation, including defining your audio interface and its inputs and
outputs, as well as details such as the Sample rate and Block size.
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USER | SETTINGS

User Interface Audio System

Driver model Core Audio
Input Device I+ Mikrofon (integriert)

Output Device I+~ Ausgang (integriert)

Ausgang (integriert)

Sample rate 44100 Hz

Block size ﬁ

Recording offset

Input busses 1 2

Stereo Input
Add Mono Add Stereo
Output busses Role 12
Stereo Output Speakers - X
Add Mono Add Stereo Add Speakers Add Headphones

To configure your audio hardware for the first time, begin by selecting
the proper Audio System for your interface. The options available here
vary based on your platform. If you are unsure of what to set, try the
first option available (there may be only one option).

The Input Device and Output Device settings specify which audio
interface you will be using for bringing audio signals into and out of
the system, respectively. Whether you plan on using audio input or not,
you must set the Output Device in order to hear anything out of Bitwig
Studio.

Once the Output Device is selected, a section of the window is added
with the same name. (In the image above, the driver's output device

is named Ausgang (intergriert) so a section also labeled Ausgang
(intergriert) follows.) Bitwig Studio will have created a stereo output pair
that is mapped to the first two audio outputs of your interface. In the
example shown above, the stereo output created by Bitwig Studio was
named Stereo Output is shown under the Output Busses header.

Names defined in the Output Busses and /nput Busses sections will
be used across Bitwig Studio to indicate audio routings. These names
can be changed here at any time.

1



For more information, see section 6.3.2.

The Output Device selected in our case above has only two available
audio outputs, and both of those are being used by Stereo Output, as
indicated by the checked boxes labeled 7 and 2. The fact that both boxes
are checked means that they are being used for the Stereo Output path,
which will be available in the program under that name.

Finally, each output path has an assignable Role. The Stereo Output path
has been defined as Speakers, making it an option for audio monitoring.
The other Role settings are Headphones (also a monitoring option) and
Output, which covers anything other than speakers or headphones.

If an /Input Device is selected, a Stereo Input will be similarly created from
the first two inputs.

Finally, the x button at the far right of each listed buss will delete that
path. So if you create a buss by mistake, just click this button.

0.3.2.2. Controllers Settings

The Controllers page allows you to designate and configure any MIDI
controllers that you will be using with Bitwig Studio.

|SETTINGS ~ PACKAGES  HELP
Takeover mode Relative scaling

Controllers E

Korg padKONTROL

Audio

Recording

() Korg nanoKONTROL 2

I Controllers

# nanoKONTROL2.control v1.0 @ nanoKONTROL2 SLIDER/...
Synchronizatio
nenronization 20 i «® 'nanoKONTROL2 CTRL
(0] MIDI Keyboard

* Generic MIDI Key ontrol v2.3.3 +>© None
® 0 !

The global Takeover mode setting determines how individual controls
and their associate software parameters interact before their values
match. Options include:



> Immediate, which fully applies any control message to its software
parameter, moving it immediately.

» Catch, which waits to move the software parameter until the control
message matches or passes the current parameter value.

» Relative scaling, which moves the software parameter incrementally
in the same direction that the control is moving (for example, turning
a knob up increases the parameter value, while turning a knob down
decreases the value). This creates a relative motion based on your
control gestures that will gradually meet the parameter value.

In the Controllers sections, the top row represents ways of adding
controllers to your setup. The toggle with circular arrows represents
auto-add mode. Enabled by default, this mode will automatically add
any detected controller to your Bitwig Studio setup if a device-specific
controller extension is also found.

The Add button allows you to add controllers manually. Clicking it
calls up a menu of various controller manufacturers, each containing
a submenu of models. If you do not find your device here, you can
choose the top menu item, labeled Generic, and select the model best
approximating your controller. Choices include:

» Keyboard + 8 Device Knobs (CC 20-27), which is useful for a device
with eight controllers that use continuous controller (CC) numbers 20
through 27. These CCs are then used for soft controller mappings.

» MIDI Keyboard, which is useful for a keyboard controller that you plan
to use as a note input device. When specifying the source of MIDI/
note messages via an input chooser, you can select all incoming MIDI
channels (the default), or you can specify one MIDI channel to listen to.

As shown in the above image with the Korg padKontrol entry, you may
see one or more unfilled rectangles with an Add button at the right.
These entries appear when a controller that was previously setup and
then manually deleted has been recognized by the computer. Since
auto-add is not available in these cases, the manual Add button is here
to let you quickly restore the device.

Below this top line are entries for individual controllers that are
configured, usually named in their title bar with the controller
manufacturer and the name of the extension (often matching the
controller model). The "power” toggle at the title bar's left edge allows
you to disable messages from the controller and extension without
removing it. And the x icon at the right is for deleting the controller
altogether.

Just below the title bar is a puzzle piece icon with the name of the
controller extension (or extension) following it. In the case that you have
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multiple extensions on your computer that work with this controller, this
line becomes a menu, allowing you to swap one extension for another.

On the right side of each entry are menus for MIDI input and output
ports (respectively) that the controller extension requires. If a device has
gone offline or been disconnected, these ports may need to be set again
before the power toggle can be enabled.

Finally, the bottom left of each entry contains a row of buttons related
to the controller's performance (see section 13.2).

0.3.2.3. Synchronization Settings

The Synchronization page provides options for both controlling
Bitwig Studio from external sources and for transmitting messages to
synchronize other platforms/hardware to Bitwig.

SETTING

Transport Sync (IN)

Sync Method off | wiiclock  [RTTETREY
MIDI Input from Max2 A oms|

MIDI Sync (OUT)

MIDI Monitor (internal.mmon) s [ wrc |

Synchronization =
: T S| MTC

MTC Rate

The Transport Sync (IN) section allows you to select the Sync Method in
use. The following three options are available:

» Bitwig Studio’s /nternal mode keeps the program'’s clock and transport
independent from the outside world.
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» The MIDI Clock mode synchronizes Bitwig Studio’s clock to incoming
MIDI clock messages from a selected M/D/ Input port. For better
synchronization, the M/D/ Input signal can be shifted positively (to
play a bit earlier) or negatively (pushing it later, into the future) in
milliseconds.

Additionally, a vertical orange slider at the far right sets the
responsiveness of Bitwig Studio to incoming tempo changes. Moving
the slider to the left results in a quicker response to new tempo
messages. Moving the slider to the right results is a more gentle
response, which can be helpful when the tempo is largely static or the
hardware in question is resulting in jittery behavior.

Ableton Link connects Bitwig Studio to any and all other programs
and devices on your local network that use Ableton's Link technology.
(Compatible software running on your own machine alongside Bitwig
Studio will be automatically found as well and can be synchronized in
the same fashion.)

A list of applications and devices that support Link can be found

on this web page [https://www.ableton.com/en/link/apps/]. For
additional information and support for these other products, visit the
appropriate manufacturer's website or support center.

Link acts as a global time keeper, keeping track of and sharing the
latest tempo and relative bar position for all "participants” (each
application and device) in a "Link session.” The rules are fairly simple:

1. When a new participant joins a Link session, its local tempo will
automatically be set to the Link session’s current tempo.

2. When a participant's transport is started, playback will wait until the
Link session's relative bar position matches the participant's starting
point. So if you hit play on a participant's transport from the top of
bar one, the transport will wait for the Link session to arrive at the
beginning of the next bar, thereby keeping everyone in relative sync.

3. When the tempo of any participant changes, the Link session’s
tempo is updated, and each participant's local tempo is
automatically changed as well.
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A general troubleshooting Q&A on Link can be found on this web
page [https://help.ableton.com/hc/en-us/articles/209073069-Link-
Troubleshooting] from Ableton.

Finally, both the MID/ Clock and Ableton Link options add a dedicated
button to the Bitwig Studio window, between the transport and display
sections of the menu/transport area (see section 2.3). These buttons
allow you to toggle the selected sync method on and off on the fly, and
the Link button also reflects the number of other participants in the
current Link session.

The MIDI Sync (OUT) section lets you set whether MIDI Clock, MIDI
song position pointers (SPP), and/or MIDI timecode (MTC) should be
transmitted to each MIDI destination. Similar to the MID/ Input offset
value, a MIDI Clock Sample Offset can be set to fine tune each outgoing
path separately. And a global setting for the MTC Rate can be set here
as well.

0.3.2.4. Shortcuts Settings

The Shortcuts page allows the reconfiguration of Bitwig Studio's
keyboard commands and the use of MIDI controller mappings to trigger
these commands.

Default keyboard mappings (My

Cmd#ShiftC X+
CmdvshiftsX X+

Cmdvbackspace X Cmdvdelete X+

I Shortcuts

CndeshinDX +
CrdsshEa X+
raEX +
=+

+

keyboard note input to Caps Lod]



https://help.ableton.com/hc/en-us/articles/209073069-Link-Troubleshooting
https://help.ableton.com/hc/en-us/articles/209073069-Link-Troubleshooting
https://help.ableton.com/hc/en-us/articles/209073069-Link-Troubleshooting
https://help.ableton.com/hc/en-us/articles/209073069-Link-Troubleshooting

On this page, you can Edit shortcuts for both the computer Keyboard
and via MIDI Controller.

To define a command mapping. locate the command you wish to map,
and then click the + button to the far right of the command. You will
then be prompted to trigger the desired mapping.

As can be seen in the image above, multiple mappings can be defined
for each command.

To remove a command mapping. click the x button at the right of the
mapping.

Once settings have been adjusted, the Choose mappings menu becomes
a text entry box where new mapping sets can be named and a Save
button appears.

When this manual refers to keyboard shortcuts, it is referencing

the program’s default shortcuts. Once you begin using your own
shortcuts, the shortcuts in this document may be inaccurate for your
use.

0.3.2.5. Other Settings

All other pages of the Settings tab are listed here in order.

» User Interface houses settings that visually alter Bitwig Studio. This
includes setting the Display Profile, the program's Scaling level for each
display in use, and Contrast settings for getting the interface to look its
best.

» Behavior contains general settings, such as what to Open on start,
whether a Template project should be used whenever you create a new
project, and other editing and cache options.

» Recording provides general Recording settings, what type of tracks
Auto-Arm when selected, the amount of Pre-Rol/ use (and whether the
metronome is activated for that period), and the amount (if any) of
Record Quantization to be used on notes.

» Locations defines several paths for Bitwig Studio, such as where My
Projects live, where My Library is stored, where My Controller Scripts
should be saved, and a number of other locations for the browsers to
use.



The section for Plug-in Locations includes folders to be scanned
for valid audio plug-ins, but it also contains preferences for which
format(s) should be displayed when a plug-in is located in multiple
formats.

All plug-ins Preferred formats

Prefer VST 3 over VST 2 (when available)
Prefer 64 bit over 32 bit (when available)

Show hidden plug-in count in Browser

When you have selected to show A/l p/lug-ins, the three following
options are irrelevant and dimmed. When Preferred formats is selected,
the options below take effect:

Prefer VST 3 over VST 2 (when available) - When both a VST 3 and
VST 2 version the same plug-in are found, this option will hide the
VST 2 version by default.

Prefer 64 bit over 32 bit (when available) - When both a 64-bit and
32-bit version the same plug-in are found, this option will hide the 32-
bit version by default.

Show hidden plug-in count in Browser - When the above settings and
your Browser's current search criteria result in plug-ins being hidden
from view, this option will display the number of hidden plug-ins. And
when enabled, this notifications also serves as a toggle, allowing you
to click the notification to temporarily show the hidden plug-ins.

All of the above options are applied to both the Browser Panel (see
section 4.1.1) and the Pop-up Browser (see section 7.1.3).

» Plug-ins provides options for how third party audio plug-ins are shown
and handled. For more information, see section 14.3.

0.3.3. Packages Tab

The Packages tab is where supported library contents can be managed
and downloaded from Bitwig.



I el ) Essentials Collection m

) Artist Collection by Bitwig Update

..=@ Extended Collection by sitwig m

Partner Collection by Bitwig Install

The Collections page is a nice summary page, indicating if any of the
four collections are available for /nstall (if they are not currently on your
computer), Uninstall (if they are currently on your computer), or Update
(if an older version is on your computer).



Beatport Sounds Loops (teaser)

i Install
seatpart Soun

Capsun ProAudio Loops (teaser)
Produdio 346 MB (311 MB}

Install

\  Irrupt System nstall
RUPT, by irrupt 948 MB (864 =
Partner Collection

[ Uninstall |

The following four pages offer granular control of and information for
the content within each collection:

» Essentials Collection is for a basic set of content to run Bitwig Studio.
This collection is recommended.

» Extended Collection is additional content from Bitwig that may be
desirable for production.

» Artist Collection is for content produced by Bitwig-affiliated artists.
> Partner Collection is for content produced by Bitwig-affiliated partners.

The Package Updates page offers a list of individual packages that can
be updated, regardless of which collection they are in.
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Source

Bitwig Online

Destination

The program'’s default behavior is to download package content from
Bitwig's servers. If you have a boxed copy of Bitwig Studio and wish to
install this content from the included DVD, switch the /nstall from: menu
selection to Choose /ocation.... In the file chooser window that appears,
select the Bitwig Studio DVD.

Also by default, the installer places all installed content and other
preferences within your current user’s folder. By clicking the ellipsis icon
(...), a file chooser will appear that allows you to select another location
for installation. (Changing this setting will also move any preexisting
library file to the new location.)

0.3.4. Help Tab

The Help tab provides links to documentation and resource both within
the application package and online.
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BITWIG

Tutoerials

Read this ) by step tutorial to learn about side chaining.

Download & Open Project

Videos

@ Visit the official Bitwig YouTube channel.

BITWIG

n of tutorials and othel hand picked by the
eam

STAFF PICKS

Again, several pages exist within this tab:

» Online Help offers information about various resources, as well as either
links to the online content or the option to Download & Open Project.

» User Guide provides links to this document in all available languages.

> For Developers contains links to various guide and references
documents and other on-board tools.

» About presents the version of this Bitwig Studio installation. It may be
useful for bug reporting, etc.

0.4. Document Conventions

Here are a few notes on the formatting of this document, particularly in
relation to the platform you may be using:

> Whenever key commands are the same for Windows, OS X, and Linux,
the command will be listed once without any comment. When the key
command is different for the platforms, the Windows/Linux version
will be listed first, and the Mac version will follow and be labeled. An
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0. WELCOME TO BITWIG STUDIO

example for the copy function would be: press [CTRL]+[C] ([CMD]+[C]
on Mac).

> If you are on a Mac, your [ALT] key might be labeled "option.” In this
document, it will always be called [ALT].

> If you are on a Mac, your "command” key might be labeled with an
apple icon. In this document, it will always be called [CMD].

> If you are on a Mac, right-clicking can also be achieved by [CTRL]-
clicking.

> Screenshots in this document were made with the Mac version of
Bitwig Studio.
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1. Bitwig Studio Concepts

This chapter is both an introduction to the program and an overview of
its structure. Please start here to get acquainted with the fundamental
concepts and related vocabulary used in Bitwig Studio.

1.1. Top-Level Concepts

Bitwig Studio is a modern digital audio workstation (DAW) that allows
you to seamlessly compose, produce, perform, and expand your music.

A file created in Bitwig Studio is called a project. You can have multiple
projects open at once, but audio will be active for only one of these
projects at a time.

Bitwig Studio projects are organized into tracks, which can be thought
of as either individual instruments or layers that should be handled
similarly. Each track contains a signal path that results in audio and has
common mixing board controls (such as volume, panning, solo, and
mute).

Clips are containers for individual musical ideas. Clips store either notes
or audio, as well as control and automation data.

Music is made in Bitwig Studio by creating a project and populating its
tracks with clips, which you can then refine, arrange, and trigger.

1.2. A Matter of Timing

As Bitwig Studio's primary task is to record and play back music, the
element of time is crucial. The transport (most closely associated with
the global play, stop, and record buttons) is the engine that drives

all time functions in Bitwig Studio. This means that for any clip(s) to
be played back, triggered or recorded, the transport must be active,
propelling the Global Playhead forward.

Bitwig Studio works with time in musical units of bars, beats, and ticks

(a set subdivision, which defaults to sixteenth notes). A final value is
stored for finer resolution, which is a rounded percentage of the distance
between the current tick and the next one. These four units are shown
together with period spacers in this way: BARs. BEATs. Tl CKs. %

For example, with a default time signature setting of 4/4, 1.3.4.50 would
represent an event happening in the first bar, on the third beat, within
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the fourth sixteenth note, exactly halfway to the next sixteenth note. The
example below uses Bitwig Studio’'s counting system to label a rhythm in
traditional musical notation:

1.3.4.50
1.1.3.00 1.3.4.00
1.1.1.00 1.3.1.00
A 3
e
e 1.2.1.00 1.4.1.00 2.1.1.00
1.2.2.00 14.2.33
1.4.3.67

1.3. One DAW, Two Sequencers

Within Bitwig Studio are two independent sequencers:

> The Arranger Timeline (or Arranger) is a linear sequencer that operates
across a standard musical timeline. This is the place for sketching and
producing full-length songs or other works.

> The Clip Launcher (or Launcher) is a nonlinear sequencer where you
can accumulate a bank of musical ideas and then mix and match them.
Clips in the Launcher can be organized into groups called scenes, either
for triggering those clips together or for composing in blocks (such as
verse, chorus, bridge, etc.).

The Arranger Timeline and Clip Launcher contain completely separate
data. Editing clips on the Arranger Timeline has no effect on those
stored in the Clip Launcher, and vice versa. But the Arranger Timeline
and Clip Launcher do interact in several critical ways:

» Clips can be freely copied between the Arranger Timeline and Clip
Launcher. When selected together, multiple clips can also be copied
back and forth, and scenes can as well.

> The result of all triggered Launcher clips can be recorded directly to
each Arranger track, allowing you to capture an improvisation that can
be edited later.

» Except when recording the Clip Launcher's output to the Arranger
Timeline, only one of these two sequencers is active at any given
time. So on a track-by-track basis, you choose whether the Arranger
Timeline or Clip Launcher is in control and can trigger its data.

» By default, the Arranger Timeline is the active sequencer for each track.
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» Each track can play only one clip at a time.

1.4. Devices, Modulators, and Other Signal
Achievements

Devices are special-function components that extend your signal paths
by modifying or transforming incoming notes or audio signals.

Every track has a device chain. In terms of signal flow, this device chain
falls between the incoming sequencer data and the track’'s mixing board
section. In this device chain you can insert as many devices as you like.
You can even use Bitwig's devices to create additional device chains.

Each device has parameters, which are settings that determine how

that device operates. Parameters are set directly within the device's
interface or via an assigned MIDI controller. Parameter values can also be
sequenced via automation, adjusted via the device's remote controls, or
manipulated by modulators, which are special-purpose modules that can
be loaded within any device.

Devices are grouped into the following descriptive categories:

» Analysis. Devices that merely visualize the signals that reach them.
They make no effect on the audio chain they are a part of.

» Audio FX. Devices that manipulate incoming audio signals before
passing them onward.

» Container. Utility devices whose primarily function is to host other
devices.

> Delay. Delay line-based processors that operate on their incoming
audio signals.

» Destruction. Distortion and other mangling processors that operate on
their incoming audio signals.

> Drum. Individual drum piece emulators that use incoming note
messages to synthesize audio.

> Dynamic. Processors that operate on their incoming audio signals,
based off of those signals’ amplitude levels and trends.

» EQ. Sets of frequency-specific processors that operate on their
incoming audio signals.

» Filter. Frequency-specific processors that operate on their incoming
audio signals.
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» Hardware. Interface objects for sending signals and/or messages to
devices beyond Bitwig Studio (such as hardware synthesizers and
effect units, etc.). This can include transmitting and/or receiving audio
signals, control voltage (CV) signals, and clock messages.

Keyboard. Keyboard instrument emulators that use incoming note
messages to synthesize audio.

MIDI. Transmitters for sending various MIDI messages via the track's
device chain. This is useful for sending messages to plug-ins or to
external hardware (when used in conjunction with Bitwig's hardware
devices).

Note FX Devices that manipulate incoming note messages before
passing them onward.

Reverb. Time-based processors that operate on their incoming audio
signals.

Routing. Devices that divert a track's signal path, allowing signals to
exit and/or reenter the track.

Synth. Synthesizer instruments that either generate their audio from
rudimentary source material or use audio samples. Incoming note
messages are used to synthesize audio.

The Grid. Devices utilizing The Grid, Bitwig's modular sound-design
environment (see chapter 15).

Utility. An assortment of devices sporting various, basic functionality.
This includes basic note message processors as well as simple signal
generators and processors.

All device chains in Bitwig Studio support both audio and note signals.
To keep these signals accessible, a few rules apply.

» Except for note FX devices, all devices receiving note signals pass
them directly to their output. (Note FX process the incoming notes
before passing them onward.)

» Except for audio FX devices, all devices receiving audio signals pass
them to their output. (Audio FX process the incoming audio before
passing them onward.)

» Many Bitwig devices possess a Mix parameter. Similar to a "wet/dry"
fader, this control blends the raw audio that entered the device into the
device's output.

In Bitwig Studio, all audio signal paths are stereo.
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1.5. A Musical Swiss Army Knife

Bitwig Studio's various viewers and editors are called panels. These
panels are the heart of the program and the places where all work
happens.

The Arranger Timeline Panel lets you see all of your project’s tracks,
create an arrangement with timeline clips, and edit track automation.

1 The Clip Launcher Panel allows you to trigger clips both freely and in
sync with the transport, copy clips into and out of the Arranger, and
sort clips into scenes.

.= The Detail Editor Panel is the graphical editor for both notes and
audio, and their affiliated data.

The Inspector Panel displays all parameters for any selected clips,
notes, audio events, or tracks (and modulation parameters for any
selected devices).

Il The Mixer Panel presents the channel strip for each track and any
subsidiary signal chains.

O The Device Panel shows the full device chain for the selected track,
including an interface for each Bitwig device and VST plug-in in use.

& The Automation Editor Panel gives you detailed control over track
automation, clip automation, and MIDI control messages.

Ml The Browser Panel allows you to preview, load, save, and tag content
from your Bitwig Studio library and elsewhere on your machine.

R The Project Panel manages your project's metadata as well as the
status of files and plug-ins being used.

#

The Studio I/0 Panel gives assorted audio and MIDI options,
such as routing the main audio buss to any pairs of speakers and
headphones, listing the current MIDI controller mappings, etc.

W The Mappings Browser Panel allows you to make and edit project-
specific connections of your computer keyboard and/or MIDI
controller(s) to your project's parameters.

lil The On-screen Keyboard Panel provides visualizations of the
selected track’s playing and incoming note messages, pitch
expressions, and timbre expressions, as well as an input method for
these data streams.

The primary interfaces in Bitwig Studio are called views. Each view gives
you access to a set of panels chosen to help you carry out a particular
musical job.
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> The Arrange View lets you focus on assembling music, particularly by
recording and ordering clips. The Arranger Timeline Panel is central
to this view along with the optional Clip Launcher Panel. All panels are
available here, and all project tracks are viewed together.

The Mix View focuses on mixing tracks and triggering clips. The Mixer
Panel is central to this view along with the optional Clip Launcher
Panel. Except for the Arranger Timeline Panel, all other panels are
available here, and all project tracks are viewed together.

The Edit View is for making detail edits to clips. The Detail Editor Panel
is central to this view along with the optional Automation Editor Panel.
Except for the Arranger Timeline, Clip Launcher, and Mixer panels, all
other panels are available here.

Bitwig Studio offers several window arrangements called display profiles.
These configurations adjust the placement of panels and even provide
additional application windows when appropriate. This is all in the name
of optimized workflows, allowing the program'’s layout to match your
current screen arrangement and the task at hand.

» Single Display (Large) is intended for use with one monitor, using a
single application window to focus on one of Bitwig Studio's views
at a time. This is the default display profile (and the one used for
screenshots within this document).

» Single Display (Small) is similar to the Single Display (Large) profile but
is optimized for use on a smaller monitor.

» Tablet is intended for use with a supported tablet computer. This
profile is optimized for touch-and stylus-based interfaces, allowing you
to play and create notes through a specialized Play View. (Depending
on your operating system and hardware platform, this option may not
be available.)

Information on Bitwig Studio’s tablet computer-specific features can
be found in chapter 16.

» Dual Display (Studio) is intended for use with a two-monitor setup,
such as a laptop screen and an external display. This profile keeps the
Arrange View on your primary display and toggles your secondary
display between the Mix View and the Edit View.

» Dual Display (Arranger/Mixer) is intended for use with a two-monitor

setup. This profile is fixed, keeping the Arrange View on your primary
display and the Mix View on your secondary display.
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» Dual Display (Master/Detail) is intended for use with a two-monitor
setup. This profile keeps the Edit View on your secondary display and
toggles your primary screen between the Arrange View and Mix View.

» Dual Display (Studio/Touch) is intended for use with a two-monitor
setup where one of the monitors is a touch-screen tablet. This profile
provides one standard window (like the Single Display (Large) profile)
for your standard monitor and a slightly modified Tablet-style window
for interacting with Bitwig via your touch-screen interface.

» Triple Display is intended for use with a three-monitor setup. This
profile is fixed, keeping the Arrange View on your primary display and
the Mix View and Edit View on your secondary and tertiary displays.

1.6. User Interfacing

Finally, a few notes to help you interact with Bitwig Studio.

» Any interface control (like a knob or curve control) can be set with
the mouse by clicking and dragging upward or downward. You can
[CTRL]-click ([CMD]-click on Mac) on the control to set its value with
the keyboard. Double-clicking on the control restores its default value.

Any numeric control (one that directly shows you numbers) can be set
with the mouse by clicking and dragging upward or downward. You
can also double-click on the control to set its value with the keyboard.

Any control at all can be fine-tuned with the mouse by [SHIFT]-clicking
the control and dragging. If you have already clicked the control, you
can also press [SHIFT] after the fact to engage this mode.

When a button is tinted orange, that control is active. The inactive form
of a control uses a neutral color, such as white, gray, or silver.

Many key commands remain available while you are clicking and
dragging an item. These include the commands for toggling panel
visibility or switching the current view.

Only one visible panel will ever have focus at a given time. Focus
follows the panel that was last clicked or activated. Panel focus is
indicated by the outer rounded rectangle being tinted silver. Key
commands that target a specific panel are available only when that
panel is in focus.

Enabling [CAPS LOCK] causes your computer keyboard to transmit
note messages. While this can be a quick way to enter notes, it will also
disable many normal key commands. If your key commands are not
working, make sure that [CAPS LOCK] is disengaged.
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» Many of Bitwig Studio’s functions already have computer keyboard
shortcuts assigned, but you can modify these shortcuts and even
assign them to MIDI controllers as well.

To globally make or modify keyboard and/or controller shortcuts:

call up the Dashboard, click the Settings tab, and then click to load
the Shortcuts page. From here, you can select between computer
Keyboard and MIDI Controller assignments, and then scroll to browse
the categorized program functions, or type to search them by action
name or assignment. From this preference tab you can also save

and switch between various keyboard mapping sets (via the Choose
mappings menu).

To assign keyboard and/or controller shortcuts for a particular project:
use the Mappings Browser Panel (see section 13.4).
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2. Anatomy of the Bitwig Studio Window

All functions and controls of Bitwig Studio are accessible through the
application window. Each window can be thought of in four vertical
slices: the header, the menus/transport area, the body, and the footer.

_]Header
Menus/
|| Transport area
"ARRANGER CLIP R Browser - Multisamples |
Tolcha Bongo Hi Flam 02 0O® +

= Collection

= Location

Fadeln  FadeOut =

e I:rd\'ui iFamcz Body

Audio3

AUDIO EVENT

M
Stretch

x n
e v el

wx_eoim Footer

We will give them each their own turn: the reliable header, the pliant
footer, the shifting menus/transport area, and finally the mercurial body.

When using the Tablet display profile, some of the elements listed in
this chapter are rearranged. For details on using a tablet computer,

see chapter 16.

2.1. The Window Header

The header of each window contains two main sections: project tabs are
found on the left, and window controls are found on the right.

Project Tabs Dashboard button Window Controls
In the center is the Dashboard button. When clicked, the Dashboard will

appear over the main window. For more information on the Dashboard,
see section 0.3.
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It is also worth noting that by right-clicking anywhere in the window
header, a context menu with display options is called up.

& Increase GUI Scaling

& Decrease GUI Scaling

DISPLAY PROFILE
Single Display (Small)
Dual Display (Studio)
Dual Display (Arranger/Mixer)
Dual Display (Master/Detail)
Triple Display

Tablet

The Increase GUI Scaling and Decrease GU/I Scaling options allow you
to resize Bitwig Studio's entire graphical user interface to be larger or
smaller (respectively) on your monitor.

By default, Bitwig Studio makes maximum use of your screen. As
such, the Decrease GU/ Scaling option may not do anything if you try
it first.

Beneath the GUI options are a list of the available Display Profile choices
(see section 1.5) for easy switching.

2.1.1. Project Tabs Section

On the far left are tabs for the Bitwig Studio projects which are currently
open. Some notes on using these tabs:

» Bitwig Studio will display the contents of only one project at a time.
This is true even if you are using a display profile that uses multiple
application windows.

» To focus on any one of the open projects, click on its tab.

> The tab that is outlined with a box and whose name appears in bright
white represents the currently viewed project. In the image below, this
is the project named 2nd.
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> Only one project at a time is capable of producing sound. This allows
you to view and even edit different projects without interrupting audio
playback of the current one.

> You can click and drag any project tab to change its position.

> If there is not enough space to show all open projects together, left and
right scroll arrows will appear around the project tabs.

> An asterisk (*) will be appended to any project's name if unsaved
changes have been made.

» The x on the right side of each tab can be clicked to close that project.

2.1.2. Window Controls Section

On the far right of the window header are options for controlling Bitwig
Studio's window size, appearance, and notifications.

Window Close button
Window Maximize toggle
Window Minimize button
Full Screen button
Notifications toggle

> Notification toggle allows you to show or hide event notifications
from Bitwig Studio. The filled circle shown above represents that
notifications are enabled, and an empty circle indicates that they will
not pop up.

When notifications are enabled, any received message it will pop up
below the window header.
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Audio Settings changed

The changes will be applied when the

Dashboard is closed
Apply Now

Most often, notifications are presented with an action button (such as
Apply Now in the above image). Notifications tinted blue-ish are largely
assistive. Notifications tinted red represent errors that could adversely
impact the performance of your project or the program itself.

Files are missing

Finally, when a message is received but notifications are disabled from
appearing, the ring of the empty circle icon is tinted based on the type
of notification that has arrived.

Full screen button switches Bitwig Studio into the full-screen mode
provided by your operating system. Once you are in full-screen mode,
the options available in the window controls section may decrease.

To exit full-screen mode: click the window maximize toggle, to the
immediate left of the window close button.

Window minimize button hides the Bitwig Studio window.

Window maximize toggle alternates between maximizing the size of
the window and restoring its original, smaller size.

Window close button is the equivalent of quitting Bitwig Studio (by
selecting File > Quit).
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2.2. The Window Footer

The window footer contains various buttons that determine which parts
of Bitwig Studio are visible, along with context-specific messages of
available actions and controller visualizations.

ARRANGE MIX EDIT

Footers will differ based on the display profile being used. The image
above — and all screenshots in this document — shows a footer from the
default Single Display (Large) profile in Arrange View, where all panels
and views are available.

2.2.1. Panel Icons

The small icons that appear in the window footer are panel icons. Each
icon represents a panel that is available within the current view. The
icons are also buttons, allowing you to toggle the visibility of each panel
by clicking its icon. An icon that is illuminated in orange indicates an
active panel.

For each cluster of icons, only one panel can be shown at a time. These
icon clusters are located either on the far-left, far-right, or center-left of
the window footer, indicating whether those panels would be displayed
on the left, right, or center-bottom of the window, respectively.

The panel icons that you will encounter are:

i1 The Inspector Panel icon is a seriffed, lowercase /. When available,
you can focus on this panel and toggle its visibility by pressing [I] or
LALTI+[I].

.= The Detail Editor Panel icon is an arrangement of dashed lines, like
a standard "piano roll" representation of notes. When available, you
can focus on this panel and toggle its visibility by pressing [E] or
[ALTI+[E].

& The Automation Editor Panel icon is two circles connected by a line,
like the breakpoints that build an automation curve. When available,
you can focus on this panel and toggle its visibility by pressing [A] or
[ALTI+[A]

O The Device Panel icon is a rounded rectangle with a shaded left side,
like the containing box for each device and its left-sided title bar and
master controls. When available, you can focus on this panel and
toggle its visibility by pressing [D] or [ALT]+[D].
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The Mixer Panel icon is a series of three wide vertical lines, like the
volume faders of a mixing console. When available, you can focus on
this panel and toggle its visibility by pressing [M] or [ALT]+[M].

il The Browser Panel icon is a folder icon, representing the library of
content that is accessible in this panel. When available, you can focus
on this panel and toggle its visibility by pressing [ALT]+[B].

B The Project Panel icon is a file icon, representing the project file
whose metadata is defined in this panel.

#

The Studio 1/0 Panel icon is a pair of opposite-pointing arrows,
representing the input and output paths that are addressed in this
panel.

W The Mappings Browser Panel icon is a right-hand with an extended
index finger, representing the connections of yourself to your project
that are made here.

Lil The On-screen Keyboard Panel icon shows the common grouping of
five piano-style keys, representing one of the note visualization and
entry methods available in this panel.

2.2.2. View Words

The capitalized, bold words that appear on the left side of the window
footer represent all currently available views. To match the views' names,
the labels used are ARRANGE, MIX, and EDIT.

A window with no view words indicates that your current display profile
is fixed and has only one available view.

For the two-window display profiles (those whose name begins with
Dual Display), available views are shown as compound names, such
as ARRANGE-MIX or MIX-EDIT. In this situation both windows show
the same view words, indicating the views shown on the primary and
secondary windows, respectively.

2.2.3. Available Actions

Available actions appear just to the right of all left-aligned view words
and panel icons. As your mouse moves around the program, any
interactive object that is hovered over will display information and
available mouse functions here.
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S O m SOLO Off  CLICK T solo/cue  SHIFT+CLICK Toggle solo/cue (and clear all others)

In the example above, a track SOLO button is hovered so the line starts
with the object name and it's status (the solo button is switched Off
currently). Possible CL/CK and modifier-click options follow. And since
I was holding the [SHIFT] key, the SHIFT+CLICK option is shown more
brightly as it will be used.

Available actions are also shown while you are interacting with the
program, as in this example when actively dragging a Launcher clip.

S Om DRAG LAUNCHER CLIPS ALT Copy SHIFT Copyd s CTRL Bounce

While dragging a clip, | am free to move it to a different clip slot or
even to an Arranger track, but additional modifiers are also available to
change the basic move action into something more complex. Available
actions are there to remind us of workflow variations for tasks that we
are already doing.

2.2.4. Controller Visualizations

Controller visualizations also use the same middle portion of the footer.
They show the current position of controls and the parameters that they
are assigned to (for any controller that has visualizations enabled).

The layout and visual style is influenced by the controller script. And
when non-immediate takeover modes (see section 0.3.2.2) are being
used, the outer ring/indicator shows the current parameter value in
white and the colored indicator shows the hardware control's current
position. Once the parameter and control meet, both elements use the
control color.

2.3. The Window Menus/Transport Area

Beneath the window header is an area where Bitwig Studio's menus live,
along with the transport and its associated displays.

File menu

Transport section Display section Object menus
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Some of these elements are persistent, and some are transitory. This is a
function of Bitwig Studio’s unique menu system, which we will examine
first.

2.3.1. The Menu System (via the File Menu)

The File menu itself contains only menu items that you would expect
and/or those which will be covered in this document at the appropriate
time. So we will take this opportunity to see Bitwig Studio’s unique menu
system at work.

PLAY P
* 4
I New Project
i Open...
+0 Save
+& Collect and Save...
+4 Saveas...

+# Save as Template...

B Close

I~ Export Audio...

© Export MIDI...

how Dashboard

£ Settings

% Quit
Fade In Fade Uut

Most items in the menu shown above have four distinct elements:

> An icon leads each entry, visually abbreviating the function of the menu
item.

> The menu item name itself is always second.

» When defined, a keyboard shortcut follows. When more than one
keyboard shortcut exists for a menu item, the first shortcut is shown.
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For information on making or altering shortcut assignments, see
section 0.3.2.4.

» Finally, a thumbtack toggle appears at end of each line.
To anchor an item in the menu area. enable the thumbtack toggle beside

the menu item. This will place a button with the menu item's icon beside
the menu button itself.

O O

I New Project

@ Open...

+0 Save

+E Collect and Save...
+& Save as...

+ & Save as Template...

Bi Close

I~ Export Audio...

© Export MIDI...

how Dashboard
& Settings

X Quit
Fade In Fade Dut

In the image above, three menu items (Collect and Save..., Export MIDI...,
and Settings) each have their thumbtack toggle enabled. And now to
the right of the File menu are three shortcut buttons, each representing
one of those menu items and showing their menu item's icon. Clicking
one of these buttons is the equivalent of triggering the menu item.

Like the File menu, each menu button is indicated with a dog-eared
triangle in its bottom right corner, hinting that the button can be
unfolded. Every menu in Bitwig Studio uses this system, allowing you to
anchor any function that you please to the top level of the program.
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If your window is ever sized too narrowly to display all menu options,
the program will prioritize by showing all menu buttons first, and then
showing as many anchored buttons as will fit the current width.

2.3.2. Transport Section

The transport section appears deceptively simple at first glance.

Play menu Automation Write (Arranger) shortcut button

Global Record
Global Stop
Global Play

Let's skip the Play menu for the moment and look at the four buttons
that follow:

» Global Play: Toggles and indicates the state of Bitwig Studio's
transport. When clicked to toggle the transport on, Arranger playback
resumes from the Play Start Position and active Launcher clips are
triggered in sync. When clicked to toggle off, the transport is stopped
and the Play Start Position is moved to the current Global Playhead
position.

» Global Stop: Deactivates the transport. When the transport is already
inactive, clicking the global stop button returns both the Global
Transport and the Play Start Position to the beginning (play position
1.1.1.00).

» Global Record: Arms all record-enabled tracks. When the global record
button is enabled, Arranger recording will begin the next time the
transport is started.

> Automation Write (Arranger) shortcut button: Enables automation
recording to the Arranger Timeline the next time the transport is
started.

The three global buttons above will always be present. The shortcut
button, however, is so named because you can toggle it in and out of
existence. This is available for many more transport options within the
Play menu.
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| 2 | | ® v

ARRANGER

—
o°w Automation Write TOUCH WRITE

Overdub

CLIP LAUNCHER

Automation Write

Overdub

@ Record on Scene Launch

GROOVE
Enable Groove

" Shuffle

s ) Accent

PLAYBACK

X Metronome

SETTINGS

m—
Pre-roll 2Bars 4Bars

—
p) 4

Default Launch Quantization
12 14 1/8

Post Recording Action / Delay I~

r—
Record Quantization 1/32 1/16 1/8 1/4

Reversera

The Play menu still makes use of the thumbtack toggle convention
(when appropriate), but it also makes special use of knobs and other
controls. There are five headers within this menu:

> The Arranger section provides settings that apply when working within
the Arranger Timeline Panel.

> The Clip Launcher section provides settings that apply when working
within the Clip Launcher Panel. Note the clip boxes around the icons in
this section, helping to distinguish the Launcher functions from similar
Arranger functions.

> The Groove section allows you to activate shuffle for all clips whose
own Shuffle parameter is enabled. Other parameters here include the
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Shuffle amount and interval (Rate), as well as the Accent amount,
interval (again, called Rate), and Phase.

All controls in the Groove section can be mapped and/or
automated.

» The Playback section provides parameters that take effect during
project playback, such as the Metronome volume and whether sub-
beats should also sound (Play Ticks).

» The Settings section offers a mix of workflow parameters, including
Pre-roll controls (for length and whether the metronome should be
active), the Default Launch Quantization setting, whether you want a
Post Recording Action to be triggered (and if you want a Delay on that
action), and whether you want Record Quantization applied to notes
(and if so, whether you want their end times to be quantized as well).

Finally, note that Bitwig Studio's audio engine can be engaged for only
one Bitwig Studio project at a time, no matter how many are open. So if

your current project does not have audio enabled, the transport section
will be replaced by a single button.

FILE Activate Audio Engine

Simply click this button to rejoin the audible world. (Just realize that this
will silence any other project that was previously using audio.)

2.3.3. Display Section

The menus/transport area’s display section provides informational
meters, numeric controls, and the odd automation-related setting.

Restore Automation Control button

DSP meter Arranger Loop toggle
Tempo Play Position Punch-In
T T T
] 106.00 1.4.4.36
p 4/4 0:02.17
| I/O meter |P\ay Time | Punch-Out
Time Signature Metronome toggle

This section contains the following items:
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» DSP meter: Displays Bitwig Studio's current CPU usage. (Clicking the
processor chip icon on the left will also load a DSP Performance Graph
window, including various details and metrics.)

1/O meter: Displays Bitwig Studio’s current disk activity for data being
read (input) and written (output), respectively.

Tempo: A control for the project’s current tempo, set in beats per
minute (BPM).

Time Signature: A control for the project's current time signature and
an optional tick setting.

The time signature's numerator represents the number of beats in each
bar. Common denominators are accepted (such as 2, 4, 8, and 76),
each number representing the type of beat counted in each bar (half,
quarter, eighth, and sixteenth notes, respectively).

The optional tick setting represents the primary beat subdivision to

be used across the project (see section 1.2). If only a time signature

is set (like 4/4), a default tick setting of sixteenth notes is used. If the
time signature is followed by a comma and an appropriate tick value
(such as 4/4,8), then that tick setting will be used. Values recognized
by Bitwig Studio include 8 (eighth notes), 12 (triplet eighth notes), 16
(sixteenth notes), 24 (triplet sixteenth notes), 32 (thirty-second notes),
and 48 (triplet thirty-second notes).

Play Position: A control for the project’s current play position, shown as
BARs. BEATs. Tl CKs. %

Play Time: A control for the project's current play time, shown as
M NUTEs: SECONDs. M LLI SECONDs.

Restore Automation Control button: Restores control of automation
after a parameter is adjusted during playback. The Restore Automation
Control button arms itself when the function is useful.

> Metronome toggle: Enables/disables the metronome whenever the
transport is active.

» Arranger Loop toggle: Activates/deactivates Arranger looping within
the Loop Selector's bounds.

> Punch-In: Causes recording to begin at the start of the Arranger Loop
Selector.

» Punch-Out: Causes recording to stop at the end of the Arranger Loop
Selector.

From the Dashboard on the Settings page, the User Interface tab has a
Transport parameter that can also Show Loop Region within the display
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area. This displays the Arranger Loop Selector's start time and length,
both to the right of Arranger Loop toggle.

2.3.4. Object Menus

The far right of the window menus/transport area is reserved for the
object menus.

cuP e S
4

Three menus generally appear here, each with their own set of anchored
items:

» The Add menu is always present. It allows you to create new tracks and
scenes.

The Edit menu is always present. It provides standard "edit” commands
for your current selection (like cut, copy, paste, duplicate, and delete),
as well as to undo (or redo) recent actions taken across the program.

The third menu is a selection-sensitive menu. If nothing is selected in
your Bitwig Studio project, then no menu appears here. But if you have
selected, say, a Clip or Event, then a menu with relevant functions will
appear. This is essentially a context menu with the option to create
shortcut buttons (using the menus' thumbtack toggles).

For example, if we made a time selection, a Time menu would be
provided in the third, selection-sensitive slot.

Also note in that last image that when a function is currently unavailable,
its shortcut button appears grayed out. As the menu item would appear,
so will the shortcut button.

2.4. The Window Body

So the window header is always the same (aside from the project tabs),
and while the footer's content and arrangement depend upon the
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current display profile, the set of controls is consistent. These two areas
give you control of the program and its behavior so they are generally
static. Not so with the window body.

The window body's purpose is to display your work so that you can edit
it in different situations. To that end, the body's appearance is always
changing, giving you the tools you need to perform specific tasks, but
certain areas of the window body are designated for consistent usage.

Inspector Panel Central Panel area

g ||||
ey

Browser - Multisamples

® # 6 am

Audio 2
b

Audio 3

L i N T aee

Secondary Panel area Access Panel area

The central portion of the Bitwig Studio window is reserved for the
central panel. The panel(s) shown here is defined by the window's
current view (either Arrange, Mix, or Edit View). The central panel
cannot be hidden, so if all other panels were disabled, the central panel
would take up the entire window body.

Below the central panel is the secondary panel area. This area is where
a second panel can be loaded for editing your project’'s content. Again,
the selection of available panels is determined by the window's current
view and the display profile being used. Most secondary panels can be
vertically resized.

On the right side of the window body is an access panel area. This area is
usually reserved for panels that deal with things other than the content
of your project. Typical access panels are the Browser Panel (which
gives access to the Bitwig Studio library and outside files), the Project
Panel (which gives access to the project's metadata and dependencies),
the Studio 1I/O Panel (which gives access to your hardware routings),
and the Mappings Browser Panel (which gives access to both MIDI
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2. ANATOMY OF THE BITWIG STUDIO WINDOW

controller mappings and project-specific computer keyboard mappings).
Each of these panels can be horizontally resized. When no panel is
loaded in this area, the central and secondary panels simply reclaim the
space.

On the left side of the window body is an area usually reserved for the
Inspector Panel. In certain display profiles, however, the Inspector Panel
is included in the access panel area. This panel is not resizable.
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3. The Arrange View and Tracks

Now that we have examined all the fixed parts and dynamic possibilities
of the Bitwig Studio window, let's enter the practical world of the
Arrange View. We will start by looking at a few key sections of the
Arranger Timeline Panel and their constituent elements. We will then
examine the track types used by Bitwig Studio along with basic track
editing functions. Finally we will get a brief introduction to the Inspector
Panel for current and future use.

3.1. The Arranger Timeline Panel

Unlike sculpture, painting, and architecture, music is an art form
appreciated over a defined length of time. That is to say, when we listen
to a piece of music, either at home or out at a venue, it unfolds over the
same amount of time and at the same pace for everyone in the audience.
While music can definitely be performed or created with improvisation
(see chapter 5), each performance has a rigidly defined structure to

us listeners. And as most productions are still based around a fixed

song structure, we will start with the Arrange View and its friend the
Arranger Timeline Panel, which is made to lay out music arrangements
in a precise way.

The Arranger Timeline Panel is unique in Bitwig Studio: it is available

in only one view (the Arrange View), and it is available in this view

only as the central panel. And as this panel is the only way to create

a traditional, linear musical arrangement within Bitwig Studio, it is
impossible to overstate the importance of the Arranger Timeline Panel
— also called the Arranger — which is seen here after a new file has been
created.
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We will start by examining various sections of the Arranger Timeline
Panel.

3.1.1. Arranger Area, Arranger Timeline, and
Zooming

The most important element here is the actual Arranger Timeline, which
is currently blank. As you may have seen here in earlier images (or from
opening a demo project), this is the area where your song arrangements
will take shape in the form of clips and track automation. Whenever

we refer to an "Arranger clip,” we mean a clip that is housed within this
Arranger seguencer.
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View Toggles Beat Grid settings

The Arranger is laid out horizontally, showing time progressing from the
left side of the screen to the right. This can be seen in the Beat Ruler at
the top of the Arranger. The integers here — 7, 2, 3, etc. — show where
each new bar begins.

To adjust the zoom level: place the mouse in-line with the bar numbers
inside the Beat Ruler. The cursor will become a magnifying glass
indicating that we are in zoom mode. Now click and hold the mouse
button, dragging upward to zoom in or downward to zoom out. You can
also drag the mouse from side to side to horizontally scroll within the
Arranger Timeline.

Other ways to adjust the zoom level include:

> Press either [PLUS] or [CTRL]+[PLUS] ([CMDJ]+[PLUS] on Mac) to
zoom in and either [MINUS] or [CTRL]+[MINUS] ([CMD]+[MINUS] on
Mac) to zoom out.

» Hold [CTRL]+[ALT], and then click and drag anywhere within the
Arranger area. If your mouse or trackpad supports a scroll function,
you can also hold [CTRL]+[ALT] anywhere within the Arranger area
and then scroll up and down.

> If you have a three-button mouse, click and drag the middle button
anywhere within the Arranger area.

» If you have a trackpad (particularly on Mac), pinch/stretch two fingers
diagonally on the trackpad.

As you zoom in on the Beat Ruler, you may notice that the bar numbers

start adding decimals. Depending on your zoom level, the timeline values
will be represented as either BARs, BARs. BEATS, or BARs. BEATs. Tl CKs.
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And within the Beat Ruler area, you can also right-click to show a
realtime ruler, displaying M NUTEs: SECONDs. M LLI SECONDs of the
project time.

“looo oot U Tle02 T loeos U loos T foos T Tloos ooy

11 1.2 1.3 1.4 21 22
I ——

3.1.2. Beat Grid Settings

As you adjust the Arranger Timeline's zoom level, you may also notice
that the grid lines within the Arranger area begin to change. This has
to do with the beat grid settings, which are found in the bottom of the
Arranger Timeline Panel and to the right of the horizontal scroll bar.

Actually, the value shown represents the current value in use. By clicking
on that value, the various Grid settings are exposed.

SNAP TO

Grid Offset
II Events

The beat grid resolution (shown above as 1/76, for sixteenth notes) tells
us what musical interval is being represented by the grid lines. In a new
project, the adaptive beat grid setting (the button at top, with a linked
magnifying glass and the word Automatic) is turned on. When adaptive
beat grid is enabled, changes to the zoom level also cause appropriate
changes to the beat grid resolution. The beat grid resolution setting will
update as the value changes.

To toggle the adaptive beat grid: click the adaptive beat grid button
within the beat grid settings, or press [SLASH].
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On a German keyboard, the key command is [HYPHEN].

To manually set the beat grid resolution: first make sure that adaptive
beat grid is disabled. Then manipulate the beat grid resolution by setting
it with the mouse or by pressing [COMMA] to lower the grid resolution
or [PERIOD] to raise it.

The beat grid resolution has an accompanying parameter right below it.
The beat grid subdivision (shown above as straight) sets the rhythmic
grouping used for the beat grid resolution setting. For example, the
default straight value means that straight duple values are being used.
Other available settings include triole or 3t (triplets), quintole or 5t
(quintuplets, or fifth-lets), and septole or 7t (septuplets, or seventh-lets).

To manually set the beat grid subdivision: first make sure that adaptive
beat grid is disabled. Then manipulate the beat grid subdivision by
setting it with the mouse or by pressing [ALT]+[COMMA] to lower the
grid resolution or [ALT]+[PERIOD] to raise it.

3.1.3. Track Headers

The horizontal lines you see within the Arrange area are the dividers
between each track lane. To the left of the Arrange area are the track
headers.

Track Color stripe
Solo button
| Mute button

Track Name

Inst1 S |IM - Level meters

1] — e — Automation Lane button

| Record Arm button

Volume fader

Track Type icon

Within each header are the following identifications, meters, and controls
for that track:

» Track Color stripe: A swatch of the track’s assigned color.
» Track Type icon: An icon to indicate the kind of track.
» Track Name: The title assigned to the track.

» Volume fader: A final level control for the track.
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» Record Arm button: Record enables the track.

» Solo button: When any track has its solo button enabled, only tracks
with solo enabled will output their audio.

» Mute button: Disables the track’s audio output.

» Automation Lane button: Toggles to reveal the automation lane section
of the track (see section 8.1.1).

» Level meters: Stereo audio meters that display the track’s output level.

3.1.4. Arranger View Toggles

Both above and beneath the track headers are the Arranger view
toggles. Similar to the panel icons of the window footer, each of these
icons is a toggle that adjusts what is displayed in the Arranger Timeline
Panel.

Clip Launcher button

Arranger Timeline button
Tool Palette menu

I

BP0l KitLoopFm @ S M

The upper toggles are:

» Clip Launcher button: Toggles visibility of the Clip Launcher Panel (see
section 5.1) within the Arranger Timeline Panel.

> Arranger Timeline button: Toggles visibility of the Arranger Timeline
within the Arranger Timeline Panel

Either the Clip Launcher Panel or the Arranger Timeline must be
visible within the Arranger Timeline Panel. If only one of these is
visible and you hide it, the other will automatically become visible.

» Tool Palette menu. This menu allows you to toggle between Bitwig
Studio's various editing tools.
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In fact, right-clicking within any timeline-based panel will give you the
option to switch tools at the top of the context menu.

]
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While the Arranger Timeline Panel is the first place we see the tool
palette, each timeline-based panel has its own tool palette. This allows
us to have a different tool selected for each individual panel.

> Pointer tool is for selecting and moving events. Clicking between
automation points along the current curve will create a new point.
And double-clicking in a blank area will create a new event of the
appropriate kind. You can switch to this tool by pressing [1], or you
can temporarily use the tool by holding [1].

As this is the primary tool in Bitwig Studio, all editing functions
described in this document presume you have the Pointer

tool engaged. If a different tool is meant to be used, it will be
specifically noted.

» Time Selection tool is for choosing an arbitrary section of time instead
of particular events. Otherwise it generally acts like the Pointer tool.
You can switch to this tool by pressing [2], or you can temporarily use
the tool by holding [2].
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> Pen tool is for drawing new events. You can switch to this tool by
pressing [3], or you can temporarily use the tool by holding [3].

> Eraser tool is for deleting relevant events from the area of time that
you select. You can switch to this tool by pressing [4], or you can
temporarily use the tool by holding [4].

> Knife tool is for splitting a continuous event into two. You can switch
to this tool by pressing [5], or you can temporarily use the tool by
holding [5].

Finally, the Pointer tool engages in smart tool switching. This is to say
that depending on where you hover over a clip or event, different tools
will become available. Specific information will be provided within this
document, but it is worth mentioning here as your cursor will tend to
shift shapes as you mouse navigate around clips.

Follow Playback
Deactivated Tracks

Effect Tracks

Track Height

Track I/O

The lower toggles are:

» Track [/O button: Toggles visibility of the Track I/O section of all track
headers (see section 4.4.1).

» Track Height button: Toggles the track height in the Arranger between
normal and half size (shown below respectively). In half size, the same
track header components are displayed with some minor adjustments.

» Effect Tracks button: Toggles visibility of effect tracks within the
Arranger Timeline Panel.

» Deactivated Tracks button: Toggles visibility of deactivated tracks
within the Arranger Timeline Panel.

» Follow Playback button: Toggles whether to keep the Global Playhead
on screen at all times in the Arranger Timeline Panel or not.
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From the Settings tab within the Dashboard, the User Interface page
offers two settings for the Playhead follow mode:

» Scroll by pages will scroll once the Global Playhead reaches the
edge of the current display area. This is the default setting.

> Continuously scroll will keep the Global Playhead centered in each
timeline-based panel.

3.2. Intro to Tracks

As we have seen in the Arranger Timeline, Bitwig Studio projects are
organized into tracks, and clips live on tracks. While clips are critical

for expressing your musical ideas, tracks contain the signal paths that
take clips out of the computer and into the audible world. Were there no
tracks, there would be no sound either.

We will look at the kinds of tracks that exist in Bitwig Studio before
discussing a few basic track operations.

3.2.1. Track Types

Bitwig Studio has five types of tracks. The four most common types are
present in any new project you create. Here again is a blank new project.
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As each type of track has its own designated icon, each track also has its
own particular use:

L An instrument track is denoted with a piano keys icon. The usual
purpose of an instrument track is to record and hold note clips that
will trigger an instrument and result in audio output.

I An audio track is denoted with a waveform icon. The usual purpose
of an audio track is to record and hold audio clips that will be played
back.

Md A hybrid track is denoted with an icon that is half audio waveform
and half piano keys. The usual purpose of a hybrid track is to record
and hold both note and audio clips. A hybrid track is not present in a
new Bitwig Studio project.

I An effect track is denoted with a downward arrow icon. The usual
purpose of an effect track is to receive portions of other tracks' audio
output, then mix them together for further processing.

A group track is denoted with a folder icon. The usual purpose of a
group track is to unite several component tracks (either instrument,
audio, hybrid, effect, or other group tracks) into one higher-level
track for streamlined mixing and editing. The track’s folder icon
appears open when its component tracks are visible and closed when
they are hidden from view. A group track is not present in a new
Bitwig Studio project.
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W A master track is denoted with a crown icon. One and only one
master track is present in each project, making him the king. The
purpose of the master track is to sum all signals that are routed
to the main audio buss. The master track also provides access
to various transport parameters (such as tempo) for the sake of
automation.

3.2.2. Creating and Selecting Tracks

As you develop any project, you will almost certainly need additional
tracks.

To create a track: go to the Add menu and select either Add Instrument
Track, Add Audio Track, Add Effect Track, or Add Group Track.

Other ways to create a track include:
» Use the appropriate key command as noted in the Add menu.

> Right-click a part of the Arranger where no tracks exist (such as
the blank space between the track headers), and then choose the
appropriate function from the context menu.

Before you can do anything with a track, it must first be selected, and
the track header is key to this. Clicking anywhere else — including in the
Arranger Timeline area — selects clips or automation, not an entire track.

When a track is not selected, the background of its header is charcoal
gray, and its text and icon are light. When a track is selected, the
background of its header is a light silver, and its text and icon are dark.

Inst1 S M Inst 1 - @
W = W

To select a track: click on the track's header.

When a track is already selected, you can press [UP ARROW] or
[DOWN ARROW] to cycle through the adjacent tracks.

To select or deselect additional contiguous tracks: either hold [SHIFT]
and then click on the final track to be included in the selection, or hold
[SHIFT] while cycling through tracks with [UP ARROW] or [DOWN
ARROW].

To select or deselect additional individual tracks.: hold [CTRL] ([CMD]
on Mac) and then click on the track to be added or removed from the
selection.
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To group tracks: select the tracks you wish to group and then press
[CTRL]+[G] ([CMD]+[G] on Mac).

To toggle the visibility of a group track’s encapsulated tracks: click on
the group track’s folder icon.

To unpack and remove a group track: select the group track(s) and then
press [CTRLI+[SHIFT]+[G] ([CMDJ+[SHIFT]+[G] on Mac).

3.2.3. Edit Functions and Moving Tracks

Once a track is properly selected, several standard edit functions can be
used.

To copy a track: select the track and then press [CTRL]+[C] ([CMD]+[C]
on Mac).

To cut a track: select the track and then press [CTRL]+[X] ([CMD]+[X]
on Mac).

To paste a track: select a track as a reference and then press [CTRL]+[V]
([CMDJ1+[V] on Mac). The pasted track will be added after the track that
was selected.

To duplicate a track: select the track and then press [CTRL]+[D]
([CMD]+[D] on Mac).

To delete a track: select the track and then press [DELETE] or
[BACKSPACE]L

Other ways to execute the above functions include:

» Select the track and then choose the appropriate function from the
Edit menu.

» Right-click the track's header and then choose the appropriate function
from the context menu.

To move a track: click and drag the track's header vertically.

3.2.4. Track Names and Colors

You may have noticed that when a track is created, it is automatically
given a name to reflect the type of track it is and its track number.

And when a track is moved around, the track number in its name is
dynamically updated. By default, tracks are set to automatically name
themselves based on certain factors. If you desire, you can override this
functionality by renaming the track.
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To rename a track: right-click the track’'s header and then choose
Rename from the context menu.

Each track is assigned a color when it is created. Like the track name,
the track color can also be changed.

To change the color of a track: right-click the track’'s header and then
select a different color from the palette that appears within the context
menu.

Add Instrument Track
Add Audio Track
Add Effect Track

Add Group Track

DUPL. DELETE

Rename

Activate/Deactivate Instrument Track
S1 Effect

£2
roup

Master
'Y uUngroup

s Enter Group

Exit Group

Convert to Instrument Track

I Convert to Audio Track

It Convert to Hybrid Track

v Auto Monitor

3.2.5. Deactivating Tracks

There are various ways to silence a track. One useful option is to
deactivate and subsequently (re)activate tracks. When a track is
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deactivated, not only is its output silenced, but any load it was placing
on your CPU is also removed for the time being. From the standpoint of
our limited computing resources, deactivating an object is as close as we
can get to deleting it — and none of our data are lost in the process.

To deactivate an active track: right-click the track's header and then
choose Activate/Deactivate Track from the context menu. Or select the
track and then press [ALT]+[A].

Any disabled track is visibly grayed out and certain interface items are
removed.

To activate an inactive track: right-click the track’s header and then
choose Activate/Deactivate Track from the context menu. Or select the
track and then press [ALT]+[A]

The deactivate and (re)activate functions can be applied to tracks,
devices, and top-level chains/layers of the Drum Machine, Instrument
Layer, and FX Layer container devices. And any plug-ins that are
deactivated will also stop accruing latency to your project.

Similarly, clips and notes can be muted and unmuted with the same
respective key commands.

3.3. Meet Inspector Panel

A context menu is available throughout Bitwig Studio. By right-clicking
on an item (practically any object or event), relevant actions that can
be taken will be shown along with certain properties of that item. For a
fuller list of the available properties, we also have the Inspector Panel.

To toggle the visibility of the Inspector Panel: click the view toggle for
the Inspector Panel (the /icon), located in the window's footer.

The Inspector Panel follows the active panel's selection, displaying

all properties of that selection. As there are many types of items in
Bitwig Studio (clips, notes, audio events, devices, automation points,
and tracks), the parameters displayed in the Inspector Panel can change
dramatically depending on what you have clicked on.

By selecting a track, the Inspector Panel displays relevant parameters of
that track.
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The text entry box at top displays the current track name (shown in
italics when the name is provided by Bitwig Studio). The color palette

is identical to the one from the track header context menu, and the
Active toggle controls whether the selected track is currently running or
deactivated.

Plenty of other parameters are shown within the Inspector Panel,
including nearly all of the meters and controls from the track header.
And we will get to the parameters that are now unfamiliar in the
appropriate sections of this document.

The main idea is that the Inspector Panel is an ideal way to see all the
parameters of most selected items. A context menu is also available
for most items and window areas. Going forward, we will primarily use
the Inspector Panel for viewing or altering parameters and the context
menu for executing functions. So this isn't "goodbye” to either option,
but rather "nice to meet you."
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4. Arranger Clips and the Browser Panel

Clips are the heart of any music that you will create in Bitwig Studio.
Since they are the smallest unit we will work with for arranging tasks,
clips can be thought of as our musical atoms. Put a different way, a clip
is the smallest musical idea that you might consider looping.

In this chapter, we will continue working with the Arrange View. As we
want to start working with clips and adjusting their basic parameters,
we must first learn about the Browser Panel. Then we will investigate
inserting clips and moving them around in the Arranger Timeline Panel,
which leads us to playing back Arranger contents and understanding
basic transport functions. Finally, we will see how to record new clips.

If our music is made of clips, then creating and capturing our music
starts here.

4.1. The Browser Panel

The Browser Panel is an organized way to access and then add various
media files to your project. The files can be part of the Bitwig Studio
library content or any other file found on your computer. The Browser
Panel has a fairly consistent layout across its tabs.
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Browser Tabs

Search Field
= Collection

= Location Bitwig Sound Effectsand ... X
4 #% Bitwig 99+

Bitwig Drum Machines 99+

Bitwig Sound Effectsan... 99+

Classic Drum Machines 99+ Navigation Pane
Nektar's Acoustic Drums 99+
Percussion 99+
Sampled Synths Vol. 1 99+
Sneaky's Acoustic Bass
% _Wundertuete Vol. 1
Surge FX LazerShot 01 A.wav
Surge FX LazerShot 01 B.wav
Surge FX LazerShot 01 C.wav
Surge FX LazerShot 01 D.wav
Surge FX LazerShot 01 E.wav
Surge FX LazerShot 02 A.wav Selection Pane
Surge FX LazerShot 02 B.wav
Surge FX LazerShot 02 C.wav
Surge FX LazerShot 02 D.wav
Surge FX LazerShot 02 E.wav
Surge FX LazerShot 03 A.wav
D
Surge FX LazerShot 02 A.wav
Length: 0.500 s Info Pane
Format: 44.1kHz Stereo 16-bit

Location: /Users/falko/Documents/In...

The Browser tabs are organized by the different types of content that
are relevant to Bitwig Studio, and the search field allows you to find
files/folders by name, creator, category, tags, etc.

The three panes below make up the file browser. The navigation pane
at top allows you to isolate your search to a specific Collection or file
Location (or in some cases, to narrow by either the Device in use or
the Category that has been selected for a file). Additional options for
the navigation pane are available by right-clicking anywhere within the
Browser Panel to call up the contextual menu.
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Browser - Devices

0D® +~ W 6 a m

~ ~

< IIn | %)
CUT  COPY PASTE DUPL. DELETE
#* Create New Collection...
B3 Create New Smart Collection...

Clear All Filters

Add Plug-in Location...

FILTER SECTIONS

v Collection

[\

v Device Type

v Category
Creator

"2 Absynth 5 FX Surround
"o Absynth 5 FX
E‘ Absynth 5 Stereo

Absynth 5

Inputs: 2 Outputs: 6

Vendor: Native Instruments GmbH
Category: Synth

Arch: 64-bit

Any item in the Filter Sections section of this menu can be toggled on or
off, including additional options that are unigque to the various Browser
tabs. Each filter that is displayed within the navigation pane can be
expanded or contracted by clicking its minimize button (appearing as a
"hamburger button,” or three stacked horizontal lines) to the left of the
section title. And when a selection has been made, that filter setting can
be cleared by clicking the x icon on the far right of the section.

Qv

T = Collection Favorites X —
Minimize buttons Location Bitwig Sound Effects X

— = File Type

Filter Clear buttons

Once a selection is made in the navigation pane, the selection pane
shows only content that matches the defined filters settings. And once
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a file is picked in the selection pane, the info pane at bottom displays
information about your file selection and usually offers a few options for
auditioning the file.

Volume fader

Automatic Preview

|Synchromze Preview

R D — Play/Stop Preview
Surge FX LazerShot 02 A.wav
Length: 0.500 s
Format: 44.1kHz Stereo 16-bit

Location: /Users/falko/Documents/In...

Starting on the right, the play/stop preview button either begins or halts
playback of the selected file. When enabled, the synchronize preview
button plays all previews at the song's current tempo. The automatic
preview option will begin the preview of any file from the moment it

is selected. And the volume fader at the far left determines preview
volume.

To select a Browser tab, click on its associated icon.

Devices
Presets

Multisamples
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4.1.1. Devices Tab

Browser - Devices
0D® ™ W 6 4
Qv
= Location
QO All Device Locations

&5 Bitwig

B System VST 2 Plug-ins
4 B8 System VST 3 Plug-ins

] Dmitry Sches
EBH My VST 2 Plug-ins
EH My VST 3Plug-ins

= File Type
= Device Type
= Category

"« FabFilter Timeless 2 (SC)
= FabFilter Twin2

;; FabFilter Volcano 2

"« FabFilter Volcano 2 (Mono)

"« FabFilter Volcano 2 (SC Mono)

"+ FabFilter Volcano 2 (SC)

Filter
e Flair
Flanger

=) rm-2
= Fvs

+ FM8FX

34 redundant p

Flanger
Stereo Flanger
Creator: Bitwig Category: Audio FX
Device type: Audio Effect

The Devices tab handles Bitwig Studio's devices as well as VST plug-ins
from folders that you have designated. In the image above, the bottom
of the list also has a clickable notification to Show 34 redundant plug-ins.
Once clicked, all plug-ins are displayed and the line toggles, allowing you
to then Hide 34 redundant plug-ins.

Plug-in search paths are set in the Locations page of the Dashboard,
as well as settings for which plug-in formats should be considered
redundant. For more information, see section 0.3.2.5.
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The navigation pane shows you the Category of devices, along with the
Collection and Location that you may wish to search by. While some
general information about the selected device is shown in the info pane,
the preview function is disabled in this tab.

4.1.2. Presets Tab

The Presets tab handles presets for both Bitwig Studio's devices and
VST plug-ins that are available. The navigation pane presents all the
various filter categories as well as the option of filtering presets by the
Device that is in use. Uniguely in this tab, you can both drag devices
from the Device area of the navigation pane directly onto your tracks.
You can also drag presets in from the selection pane, as usual.

To edit the metadata for a preset. right-click the preset and then choose
Edit File Metadata... from the context menu. Add or remove any 7ags in
the following window, change the Category if you like, and select Ok.

Category [Bell

Tags (digital X (dirtyX (darkX ‘modX |

fast slow hard soft

bright | clean |

mono poly glide chord

fx wet seq

acoustic metallic analog

harmonic  detuned layered noisy

Cancel

The search field itself has a couple of options for this tab that can be
accessed by clicking the magnifying glass icon.
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Browser - Presets
O® ~ W 6 a m
Q. X

S

ORGANIZE DEVICES BY
Instrument X

® Vendor

O Location

SEARCH HISTORY

eq

"a GuitarRig5
=77

This setting affects the Device filter, which is unique to this tab. When
the ORGANIZE DEVICES BY parameter is set to Location, the plug-ins
will be organized by the folder they are in. When Vendor is selected, the
plug-ins will be organized by the name of their manufacturer.

4.1.3. Samples Tab

The Samples tab handles audio files from both the Bitwig Studio library's
samples folder and folders that you have designated. Files found here
can be loaded anywhere that audio is accepted.

4.1.4. Multisamples Tab

The Multisamples tab handles files from both the Bitwig Studio library's
multi-samples folder and folders that you have designated. Files found
here can be loaded into Sampler devices.

The preview function is disabled in this tab.

4.1.5. Music Tab

The Music tab handles recognized media files from music folders that
you designate. This includes iTunes libraries. Files found here can be
loaded anywhere that audio is accepted.
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4.1.6. Clips Tab

The Clips tab handles files from both the Bitwig Studio library's clips
folder and folders that you have designated. Files found here can be
loaded into both the Arranger Timeline and the Clip Launcher.

To edit the metadata for a clip: right-click the preset and then choose
Edit File Metadata... from the context menu. Enable/disable any Tags in
the following window and select Ok.

Tags analog X broken X full X loopX quirky X
one-shot 4x4
no-kick no-highs sparse

deep dirty dry wet

acoustic metallic digital
heavy | dubby organic

smooth atmo epic wonky

4.1.7. Files Tab

The Files tab allows you to navigate across the current project, any
bookmarked folders or library locations, your local user folder, your
entire computer, and recent files.

The search field is not present in this tab.

4.2. Inserting and Working with Arranger Clips

Now that we have met the Browser Panel, we will put it to use as a
source for clips.
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4.2.1. Inserting Clips

While material from several of the Browser Panel tabs can be inserted as
clips, we will demonstrate with something from the Clips tab.

To insert a clip on an Arranger track: click and drag the clip from the
Browser Panel to the desired timeline position on the appropriate track.

Browser - Clips.
O®@ +~ W 6 aw
Inst1 {Barefoot Beat ar x
W = =
= Collection
Audio 2 = Location Bitwig Drum Machines X
- O AllClip Locations
4 Packages

4 @ Bitwig

S1Effect
3

Master

Barefoot Beat 01 C
Barefoot Beat 01D

(] Barefoot Nokick 01
T B

Barefoot Beat 01D
Creatol

L p—

Since we are dragging a note clip, it made the most sense to place
it on a note track, but we could have dragged it to any track. As the
concept of hybrid tracks may have indicated, Bitwig Studio is rather
free with the idea of track types.

If you drag a note clip to an empty audio track, the track will be
converted to an instrument track. If you drag a note to an occupied
audio track, the track will be converted to a hybrid track. In both
cases, the converse is true as well.

So inserting clips from the browser is as simple as dragging them into
the Arranger Timeline.

To insert a clip on a brand new Arranger track: click and drag the clip

from the Browser Panel to the desired timeline position between
existing tracks.
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This method of inserting clips will work from any Browser tab whose
contents can be placed on tracks. And the same method will work when
dragging appropriate files from your file manager application (i.e, File
Explorer on Windows, Finder on Mac, etc.) directly onto the tracks.

4.2.2. Moving Clips and Snap Settings

To move a clip within the Arranger Timeline Panel: click and drag the clip
with the mouse.
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4 @ Bitwig
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Master
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(] Barefoot Nokick 01

I E
Barefoot Beat 01D

> s M
.| SDTight...
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The result will be similar to when the clip was originally inserted from
the Browser Panel. But also note that as you begin dragging the clip

to move it, a status message appears in the window footer with several
additional options. (This is shown in the image above; note that the
order of options varies by platform, and your screen may not match the
sequence in this image.)

Do look for status messages whenever you are clicking and dragging
items in Bitwig Studio. This document will not necessarily cover all
variations that are shown within the program.

The first option — that adding [CTRL] ([ALT] on Mac) while dragging a
selection toggles between moving and copying — was mentioned in a
previous chapter.

The second option is new and indicates that [SHIFT] toggles from
obeying the beat grid to ignoring it. Whether and how clips conform to
the beat grid is governed by the snap settings, which are found in the
bottom right corner of the Arranger Timeline Panel, by clicking on the
beat grid settings.
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IC
Grid Offset

Automation Follow button

Found under the Snap To header, three independent options determine
which elements clips will or will not snap to as you drag them across
time. As each option only provides additional anchor points, the options
have no effect on one other.

> The Grid option causes clips to snap to the current beat grid.

This option can be toggled by either clicking on the icon or pressing
[SHIFT]+[COMMA] while the Arranger Timeline Panel has focus.

» The Grid Offset option uses the current beat grid resolution, but it
thinks of a grid in relation to the clip's current start time. So if the clip
does not start exactly on the beat grid, the amount that the clip is
offset will be preserved when it is moved.

This option can be toggled by either clicking on the icon or pressing
[SHIFT]+[PERIOD] while the Arranger Timeline Panel has focus.

» The Events option causes clips to snap to the start and end of other
clips within the Arrangement Timeline.

This option can be toggled by either clicking on the icon or pressing
[SHIFT]+[SLASH] while the Arranger Timeline Panel has focus.

On a German keyboard, the key command is [SHIFT]+[HYPHEN].

If only one of these options is enabled, only that snapping rule applies.
If multiple options are enabled, clips will momentarily snap into place
for each and every rule that applies. And when none of these rules
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is enabled, clips will move freely, the same as when you hold down
[SHIFT].

These settings will apply not just to moving clips, but to any other
editing action in the panel. We will touch upon some of those actions in
a moment, but one other option is worth mentioning here.

In the above image, note the automation follow button, directly beside
the beat grid settings. Toggling this function determines whether
automation is moved along with clips or not. So if you are moving clips
around, be sure to check the status of this button.

4.2.3. Adjusting Clip Lengths

To demonstrate working with the Bitwig Studio's various tools in the
Arranger Timeline Panel, we will start with the task of removing the
second half of a clip.

To shorten an Arranger clip: mouse over the top right edge of the clip so
that a half-bracket cursor appears. Then click and drag to the left.



Other ways to shorten an Arranger clip include:

» With the Time Selection tool, click and drag over the time area that
should be removed. Then clear the time by pressing [DELETE] or
[BACKSPACE].

» With the Eraser tool, click and drag over the portion of the clip to be
removed.

» With the Knife tool, click the position where the clip should be
separated. Once the clip is divided, select and delete — [DELETE] or
[BACKSPACE] — the unwanted clip.
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Barefoot Beat 01 D

All of these methods achieve the same effect. And while it may seem
like the second half of our clip is now gone forever, this is not the case.
Bitwig Studio still remembers the full contents of our clip in case we
need it back later.

To lengthen an Arranger clip; mouse over the top right edge of the clip
so that a half-bracket cursor appears. Then click and drag to the right.

p
Barefoot Beat 01 D

Bitwig Studio acts rather nondestructively, internally preserving data
whenever practicable. But you can always ask the program to stop
considering data that is not currently visible by using the consolidate
function, which essentially solidifies a clip for various purposes.

To remove unseen data from a clip: right-click the clip and then choose
Consolidate from the context menu.

After consolidating the previous clip, extending it would now work
differently.
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Barefoot Beat 01 D

To consolidate multiple clips. select all of the clips. Then right-click one
of the clips and choose Consolidate from the context menu.

For all of the above purposes, the consolidate function is also available
by selecting Edit > Consolidate or by pressing [CTRLI+[J] ((CMDJ+[J] on
Mac).

4.2.4. Sliding Arranger Clip Content

The content of one or multiple clips can also be shifted left and right
from the Arranger Timeline Panel. Sliding content in this fashion
preserves the boundaries of each clip, simply sliding the contained note
or audio events (including any associated expressions) earlier or later in
time.

To slide the content of a clip. mouse over the top half of the waveform.
Then [CTRL]-click ([CMD]-click on Mac) and drag horizontally.

Barefoot Beat A 04

You can optionally add the [SHIFT] key while dragging to toggle the
snapping behavior.
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4.2.5. Applying Fades and Crossfades to Audio

While most functions in this chapter are applicable to both note and
audio clips, the options to fade in, fade out, and crossfade are only
relevant to audio clips.

To create a fade in. mouse over the middle of the clip's left edge, at the
top of the waveform display. Once a white triangle appears, click and
drag the triangle toward the center of the clip. Release the mouse where
you would like the fade to end.

Fade outs can be created in the same way by mousing over a clip’s right
edge.

Creating a crossfade requires audio clips that are overlapping and have
material extending beyond their own boundaries.

To create a crossfade: mouse over the middle of the intersection of
the clips, at the top of the waveform display. Once two white triangles
appear, click the triangle where you would like the crossfade to
boundary to be, and then drag across the clips' border. Release the
mouse where you would like the boundary of the crossfade to be.

That is a bit of a mouthful so let's take a moment unpack the process.

79



If you click on a clip's edge and drag toward its center, you are creating
a fade in or fade out for that single clip. So creating a crossfade requires
clicking on one of the overlapping clips and then dragging the fade past
its boundary and onto the other one.

If you start by clicking in clip T and then drag across to clip 2, the
crossfade will begin where the boundary was and will end wherever you
release the mouse. If you start by clicking in clip 2 and then drag across
to clip 1, the crossfade will end where the boundary was and will end
wherever you release the mouse.

To adjust the boundaries of any fade: mouse over the top portion of a
fade so that its white triangle(s) appears, and then click and drag to
move the fade's boundary relatively.

Note that for a crossfade, dragging an inner boundary will select both
curves (shown as highlighted in white) and let you adjust them together.
Dragging an outer boundary will let you adjust the closest fade by itself.

To adjust the slope of a fade: mouse over the fade's curve, and then click
and drag the mouse up or down.

If may be difficult to get the curvature cursor to appear if your track
height is small. If you are working a good amount with fades and their
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curves, you should make your track's height larger than the minimum
by clicking and dragging the bottom of the track header.

05 - Forked Deer

Note again that with a crossfade, you can either mouse over both fade
curves to manipulate them in tandem, or you can adjust each fade by
itself.

To shift an entire crossfade. mouse over the bottom of the crossfade,
and then click and drag backward or forward in time.

4.2.6. Looping Clips

As clips are intended to be the smallest practical musical idea, you may
want to loop clips.

To loop an Arranger clip. mouse over the bottom right edge of the clip

so that a half-bracket cursor appears with a looping oval. Then click and
drag to the right.
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After you drag the clip beyond its full length, additional copies will be
generated. The first copy starts with a dashed vertical line, marking

the loop length being used. All subsequent repetitions of the loop are
marked with dotted vertical lines. Once the clip is looping, you can do
the same using any of the "bracket” tools, either at the end or beginning
of the clip.

To adjust the loop length of an Arranger clip. mouse over the clip's

first repeat marker (the dashed vertical line) so that an I-beam cursor
appears with a looping oval. Then click and drag in either direction.

4 _ H
Barefoot Beat 01 D

)

The length of the clip itself remains the same while the section of the clip
that loops — and accordingly the number of repetitions — has changed.

4.2.7. Meta Clips and Group Tracks in the Arranger

When working with a group track, the contents of its enclosed tracks
are summarized in the Arranger Timeline. When no clips within the
group track are overlapping, these meta clips are essentially direct
representatives of their contained clips.
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When the enclosed track do have overlapping clips, affected meta clips
adapt to show colorized summaries of the track contents.

‘=~ Project

Group 1
[}

Corrupt Monkey ® S
W

RC Snare 03 Fun...

S1Effect

Regardless of the display style, each meta clip acts as an alias of the
clip (or clips) that they represent. As with any regular Arranger clip,
meta clips can be moved by dragging and dropping, they can be cut or
copied or pasted in the normal ways, they can be deleted, and they can
even be split with the Knife tool. Taking any of these actions on meta
clips directly affect the clips that they represent.

When working with group tracks, a project navigation menu appears at
the top of the Arranger Timeline Panel within the Arrange View.

Other Group

Subgroup
hid

RC Snare 03 Fungus

Other Group
[}
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Clicking on this menu exposes a hierarchy of the current project,
including the top level of the Project and all group tracks that are
present. Selecting one of these group tracks changes the context which
the Arranger Timeline Panel displays.

“= First group t

RC Snare 03 Fun...
[

Corrupt Monkey
hid

First group Master ® S
L

To the right of the project navigation menu, a "left turn” arrow has now
appeared. Clicking this arrow navigates upward into the parent level

of the current context. It is also worth noting that the context selected
in the Arranger Timeline Panel is preserved if you switch to the Mixer
Panel.

1] - L
Corrupt Mon... RC Snare03 F... First group M...

Polysynth

A - "

WAalins - 4 X Noinput  ~ * No input

I First group .~ e First group.~ - Master

Finally, back in the Arranger Timeline Panel, you can toggle between
viewing each group track’'s meta clips or a representation of the group
track’'s master track.

To view the contents of the group track’s internal master track: right-

click on the group track's header, and then select Show Master Track
Content from the context menu.

84



1 2
e ————————

‘=~ Project

Group 1
[}

Rename
Enter Group
Corrupt Mor _
W Ungroup Group Track

Pe— Show Master Track Content * B

+ Show Group Track tent

Create Instrument Track

o i Create Audio Track

You can switch back to displaying the meta clips by calling up that same
context menu and then selecting Show Group Track Content.

4.2.8. The Inspector Panel on Arranger Clips

While the Arranger Timeline is a convenient, graphical view for

working with the length and loop settings of a clip, all of those mouse
movements are really just triggering parameter changes in the Inspector
Panel. By investigating these parameters (along with the associated
functions available in the Clip menu), we will get a clearer understanding
of what is possible in Bitwig Studio in general and the Arranger in
particular.

We will start by focusing the Inspector Panel on the same clip looping
example we just finished.

'ARRANGER CLIP

foo at 01 D

. :l Barefoot Kit
Al

(

For the time being, we are just paying attention to the parameters in the
ARRANGER CLIP portion of the Inspector Panel. We have already seen
the name and color options for tracks (see section 3.2.4). The remaining
sections offer additional parameters.
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4.2.8.1. Signature Section

Signature sets the time signature of the selected clip. Along with an
optional tick setting (see section 2.3.3), this reflects how the clip is
displayed for editing.

4.2.8.2. Time (Position) Section

These settings relate to the musical time or position of the selected clip:

> Time sets the start of the clip in the Arranger Timeline. Adjusting this
position will simply move the clip exactly as it exists, the same as
clicking and dragging the entire clip in the Arranger.

» Length sets the duration of the clip in the Arranger Timeline. Adjusting
this duration will simply lengthen or shorten the clip, the same as using
the bracket cursor to adjust the right edge of the clip.

» Offset preserves the position and length of the clip, but shifts its
internal content by the set amount. This is the same as using the
bracket cursor to move the left edge of the clip forward in time.

Taking the previous image as an example, | could increase the Time
from 2.1.1.00 to 2.2.1.00. The entire clip is now happening a quarter note
later.

ARRANGER CLIP

Barefoot Beat 01D

Barefoot Kit
[}

EEEEEN

Time -

TTE AT

Length

Offset

But if | wanted the clip to stay in time and simply skip the first beat
it was playing, | would increase the Offset from 1.7.7.00 (no offset) to
1.2.1.00.

ARRANGER CLIP

Barefoot Beat 01D
Barefoot Kit
1]

Audio2

mw= m=

Note that the first beat is included in subsequent loops.
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4.2.8.3. Loop Section

These settings relate to the looping of the selected clip:

» Loop toggles whether or not the clip loops with the Arranger. When
disabled, the clip will play only once. If the size of the clip is longer than
its contents, the later portion of the clip will be empty.

ARRANGER CLIP

t01D

ar
| || Barefoot Kit
W

Audio 2

L3
=
(]

-r "

If Loop is off, the other settings here are ignored.

Start is the looping equivalent of the Offset parameter, keeping the
clip contents in their place but delaying the point at which each loop
repetition starts.

Taking the same example from above, | could increase the Start from
1.1.1.00 (no loop offset) to 7.2.1.00, causing each one-bar loop to end in
the same place but start a quarter note late.

ARRANGER CLIP

>

Barefoot Beat 01D

| | | | Barefoot Kit
W

Audio 2

[
|.- E

Length sets the duration of the clip that is being repeated. This is the
same as using the I-beam cursor with a looping oval to graphically
adjust the loop length.
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4.2.8.4. Fade Section

Length

Fade In Fade Out 05 - Forked Deer

As stated earlier, fade actions and parameters apply only to audio clips.
So these twin sets of parameters represent controls for any Fade /n and
Fade Out applied to the selected audio clip. Taken from top to bottom:

» The musical time value represents the length of the fade. If it is set to
zero (0.0.0.00), then no fade is applied regardless of the other settings.

» The buttons allow toggling the fade's curvature type between a
standard linear curve and an S-curve, respectively.

> The level value sets the amplitude at the fade's midpoint, effectively
shaping the fade's curve.

As shown earlier in the Arranger, crossfades are really comprised of
two separate fades (a fade out from the first clip, and a fade in on

the second). As such, their settings can be coordinated or handled
completely independently.

4.2.8.5. Mute Section

Mute toggles whether or not the selected clip is disabled on playback.
This is in contrast to the track mute button, which disables all contents
of the track.

4.2.8.6. Shuffle Section

These settings relate to the groove of the selected clip:

» Shuffle toggles whether or not the Global Groove parameters are
applied to the clip. If Shuffle is off, the other setting here is ignored.

» Accent sets the percent of the Global Groove's accent Amount that
should be applied to this clip.
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For example, if the Global Groove's accent Amount is set to 100% (the
default setting) and the clip's Accent setting is at 30%, then the clip will
apply an accent at 30% strength (30% of 100%).

Or if the Global Groove's accent Amount is set to 50% (the default
setting) and the clip's Accent setting is at 50%, then the clip will apply
an accent at 25% strength (50% of 50%).

Since this is a scaling function, either parameter being set to zero (0%)
results in no accent.

4.2.8.7. Clip Menu Functions

These functions take the specified action on the selected clip:

» Double Content makes the selected clip twice its current length and
duplicates its non-looping contents.

» Consolidate merges all selected clips (on a track by track basis) into
single, contiguous clips.

» Reverse flips the order and positions of the clip’'s contents, causing
them to play "backwards.”

» Scale 50% simply halves the length of a looping clip. This is the same
result as dragging its end point exactly halfway toward the start.

The following images demonstrate a selected looping clip both before
and after the Scale /2 function is applied:

For a non-looping clip, it halves both the length of the selection and
the duration and positions of its contents, effectively causing the clip to
play back twice as fast.

The following images demonstrate a selected non-looping clip both
before and after the Scale 50% function is applied:
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» Scale 200% simply doubles the length of a looping clip. This is the same
result as dragging its end point so that the entire clip is now twice as
long.

The following images demonstrate a selected looping clip both before
and after the Scale 200% function is applied:

| —
I
1

For a non-looping clip, it doubles both the length of the selection and
the duration and positions of its contents, effectively causing the clip to
play back half as fast.

The following images demonstrate a selected non-looping clip both
before and after the Scale x2 function is applied:

» Bounce In Place replaces the selected clip with a new audio clip. When
the selected clip was an audio clip, the sound source is the audio itself,



which will be printed into a solid clip. For a note clip, the sound source
is the first instrument device in the track's device chain.

For additional information on this function, see section 11.2.2.

Bounce prints the sound source of the selected clip into a new, solid
audio clip (the functional equivalent of a "consolidated” clip). For an
audio clip, the sound source is the audio itself, which will be printed
into a solid clip. For a note clip, the sound source is the first instrument
device in the track's device chain.

For additional information on this function, see section 11.2.1.

Slice To Drum Machine... produces a new instrument track loaded with
a Drum Machine device, which contains a series of audio clips (loaded
in Sampler devices) representing the original clip's content. The track is
loaded with a note clip that is configured to trigger the Drum Machine
in a fashion that reproduces the original clip.

For additional information on this function, see section 11.3.2.

Slice To Multisample... produces a new instrument track loaded with a
Sampler device, whose multiple samples represent the original clip's
content. The track is loaded with a note clip that is configured to
trigger the Sampler in a fashion that reproduces the original clip.

For additional information on this function, see section 11.3.1.

Reset Fades removes any applied fades from the selected audio clips.

Auto-Fade applies a quick, relative fade in and fade out to all selected
audio clips.

Transpose Semitone Up shifts the pitch of all note events in selected
note clips up by one half step.

Transpose Semitone Down shifts the pitch of all note events in selected
note clips down by one half step.
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» Transpose Octave Up shifts the pitch of all note events in selected note
clips up by twelve semitones.

» Transpose Octave Down shifts the pitch of all note events in selected
note clips down by twelve semitones.

» Quantize... moves the start and/or end times of all events in the
selected clip(s) in relation to a beat grid. A parameter pane appears
after this function is selected.

Grid Mode Shuffle
218 Custom | 0.00%

Humanize
Custom Grid
0.00 %
1/2 1/4
1/8

1/32 1/64 Start Amount

18 1/256

f traight LI End Amount
Quintole Septole 0.00 %

For additional information on the parameters available for the
quantize function, see section 10.2.2.4.

» Make Legato adjusts the length of each event in the selected clip(s)
so that it ends immediately before the next event begins. This creates
a continuous series of events by both extending events beyond rests
to the beginning of the next event and by shortening events which
overlapped their successor.

» Save Clip To Library... stores the selected clip in your library, allowing
you to first set various tags for the clip.
4.3. Playing Back the Arranger

How to play Arranger clips is simple enough: you play the Arranger. But
there are a few details worth getting into at this point. Let's begin this
discussion with the elements that enable basic playback.
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Global Playhead
Play Start Marker

To play the Arranger timeline: engage the transport by pressing either
[SPACE BAR] or [P], or by clicking the Global Play button.

To stop the Arranger timeline: disengage the transport by pressing either
[SPACE BAR] or [P], or by clicking the Global Stop button.

The Global Playhead is an indicator of where the transport has most
recently played. In the Arranger Timeline, it is represented with a
vertical black line. Whenever the transport is active, the Global Playhead
progresses through the Arranger tracks, and its location is noted by the
play position display in the window header.

The Play Start Marker is the blue, right-facing triangle within the Beat
Ruler that indicates where the transport will play from the next time it is
engaged.

To move the Play Start Marker: single-click in the top half of the Beat
Ruler.

Other ways to move the Play Start Marker include:

» Single-click anywhere within the Arranger Timeline with the Pointer
tool.

» Click and drag the play position in the window header's display section.

» Select a single Arranger clip to move the Play Start Marker to the
beginning of that clip.

To play the Arranger timeline from the beginning: press [ALT]+[SPACE
BAR] or [ALTI+[P].

To play the Arranger timeline from the Global Playhead'’s position. press
[SHIFT]+[SPACE BAR] or [SHIFT]+[P].
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To stop the Arranger timeline and advance the Play Start Marker: click
the Global Play button.

The Arranger Loop Selector sets the region of the Arranger Timeline that
will be looped during playback. This region is also used for several other
functions.

To toggle the Arranger Loop function: click the Arranger Loop toggle in
the window header.
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